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EEGLAB Matlab toolbox

Neuroscience

main graphic interface

EEGLARE Shell - Konsole

Session Edit View Bookmarks Settings Help

| TR

/home/arno> matlab -nodesktop
<« MATLATEB >
Copyright 1984-2002 The MathWorks, Inc.
Version 6.5.0.180913a Release 13
Jun 18 2002

Using Toolbox Path Cache. Type "help toolbox_path_cache" for

For product information, wisit www.mathworks.com.

>> eeglabl]

File Edit  Tools Plot  Study Datasets  Help

To get started, type one of these: helpwin, helpdesk, or demo.

—MNo current dataset

- Create a new or load an existing datasat;

Lze "File > Import data” (e
Or "File > Load existing dataset” (old)
= If new,

"File = Import epoch info” (data epochs) else
"File > Import event info" (continuous data)
"Edit = Dataset info" (addfedit dataset info)
"File = Sawve dataset" (save dataset)

- Prune data: "Edit > Select data”

- Peject data: "Tools > Beject continuous

- Epoch data: "Teeols » Extract epochs”

- Remowve basealine: "Toals > Remowve

- RBun ICA: "Toals > Run [CA"
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Importing a dataset

Troubleshooting data formats...

Load existing dataset
Save current dataset(s)
Save current dataset as

Clear dataset(s)

hinfo" (data
info" {continuous
0" (add/edit dataset

set" (save dataset)

Create study »
— > Select data”
Load existing study > Reject
Save current study [g = Extract epochs”
Save current study as > "Tools = Remove
5 = Run ICA"

Clear study

Mernory and other options

History scripts

Cuit

File | Edit Tools Plot Study Datasets Help &
Import data » Using EEGLAE functions and plugins * From ASCI/float file or Matlab array
Import epoch info r Using the FILE-IQ interface From Metstation .mff (FILE-IO toolbox)
Impaort event info » Using the BIOSIS interface From Metstation binary simple file
Export k

From Multiple seq. Metstation files
From Metstation Matlab files

2
Center for
Compumlonal
Neuroscience

From BCI2000 ASCI file

From Snapmaster SMA file

From Meuroscan (CMT file

From Meuroscan .EEG file

From Biosemi BOF file (BIOSIG toolbox)
From Biosemi BDF and EDF files (BDF plugin)
From EDF/EDF+/GDF files (BIOSIG toolbox)

From AMT EEProbe .CMT file
From AMT EEProbe AVE file

EEGLAB
supports
many
different
raw data

formats

From BCI2000 .DAT file

From BIOPAC MATLAE files

Fram Brain Vis, Rec, whdr file

Fram Brain Vis, Anal. Matlab file

From CTF folder (MEG)

Fram ERPSS .RAW or .RDF file

From IMStep ASC file

From 40 .mdd pdf file

From Procom Infinity Text File




Imported EEG data

i / i ; ‘ L ) /- N

IR Swartz

I Center for
Computational

Neuroscience

FEGLAB v7.1.6.18

File Edit Tools Plet 5Study Datasets Help

EEGLAB GUI
displays dataset

basics
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Load an existing dataset

»&1‘5 o\
Swartz’?: )
Center for
Compumlonal

Neuroscience

Lock in: I o7 j 4= =k EE
- Mame Date modified Type Size
B oo o2z i 900 oo |Tn | 2me
ISl Edit Tools Plot Study Datasets Help | L memorizes : he ’
| | || probe.set 3/13/20097:29 AM ST File 68,307 KB
Import data ' set Desktop || sources.set 3/9/2009 440 PM  SET File 1,300 KB
Impaort epoch info » u_g | || stern.set 3/9/200912:38 PM  SET File 171,540 KB |
Inpurmzsznzind ' orload an existif| ot
Export » port data" .
S . . |
Load existing dataset d existing data ml

Computer

Sawe current dataset(s) :
poch info" {dat

Sawve current dataset as :
L wvent info" {cont

Clearsdutasstls) - info" (add/edit
Create study P taset" (save dz
Load existing study dit = Select dat frz

ools = Heject
ools = Extract |
ne: "Tools = Remaove
als = Run ICA"

Sawe current study Files of type:

Sawe current study as

Clear study

Memaory and other options

History scripts ]
Quit
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Pre-processing pipeline
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Import data events
-

7 Chntepfor

\x ,v C(;m;;uta;'fonal
&é? Neuroscience
r!] EEGLAB v7.17.18b | |
Edit Tools Plot Datasets Hel o .
mlmpmata : [« Import events from Matlab array or ASCII file

]
, ‘ontinuous -- Rere... .

N

: : < . .
“’”‘ “'”“""”“’:Hf"* | Import from Presentation event file
xport | -
: " | * Import from Neuroscan file

Load existing dataset From Presentation .LOG file
Save current dataset(s) From Meuroscan .ev2 file
L
Sawve current dataset as 1303
Clear dataset(s) 2a0
Create study ] 0.000 ¢ =] ™
-~ 2440528 | [ Extract event from channel(s) - pop_chanevent() l-':" ﬂ
Load existing study
il
Sawve current study Yag
Save current study as Yeg B =) 72
Cl tud
Ear Study 344 Preprocessing transform (data="4" Optional. Ex: X=3
Memory and other options Transitions to extract? (upldown) up (leading) H (click to select)
v History scripts ] e Transition lencgth (11 =perfect edges) 0
——
Quit Azzign duration to each evertz? |:| [zet=yez)
Delete evert channel(=]? [zt = yes)
) ) | Delete old events if any?
Often imported automatically Al everts of same type? ]
during data import — | Help | =
e
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Appearance of an event channel in raw data

Computatlonal
Neuroscience

‘?, =% Scroll activity — eegplot()
Figure Display Seftings Help

Scale
50

4 3 B 7 i 9
Chan. Time YValue

CLOSEI EVEI’I“&‘FIBSI <<l .E..II 4 _1_] >->| 1 91818 31457 | a0 j
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Imported data events

i / l ; ! o M oo /2

gl Bt b o b e U e B s

IR Swartz

I Center for
Compu(ational

euroscience

>> BEEG.event
ans =

1x1303 struct array with fields:
Trial

Event Type EGLAB 171718 R ==~

type N If event import was
latency

TTime successful,
Uncertainty you will see an
Duration .
Uncertainty?2 appropriate
RegTime number here
RegDur

init index
init time
urevent
duration
load

rt
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Review event values

/-
/

IR Swartz
Center for
Compu(ational
Neuroscience

BN EEGLAB v7.17.

File @il Tools Plot Study Datasets Help

Dataset info
Event fields

Event values MOSt
About this dataset relevant
fields

Delete event

Event_Type Picture

Type narm
Latency (sec)

Channel locatians

Time

Select data
Select data using events

Uncertainty
Duration

Uncertainty2

Select epochs or events

Copy current dataset Number of ReqgTime
Append datasets _ H.e:.qﬂur
Delete dataset(s) event fields Init_indesx

Init_time

IS unlimited

Duration (sec)
Load

Insert event
BEFORE
current event

To resort: first
select Main
sorting field
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Import channel locations

)science

Opt. head center

Rotate axis

File M08 Tools Plot Study Datasets Help Transform axes

Dataset info
Event fields
Eventwvalues
About this dataset

Xyz -= polar & sph.

Sph. -= polar & xyz

Polar - sph. & xyz

Select data

Set head radius
Set channel types

Select data using events

Select epochs or events

Copy current dataset Set reference
Append datasets
Delete dataset(s)

Visually edit events and identify bad channels

e

Flot 2-D L MlINose along +X u Plot 3-D (xyz)
Fead locs help Look up locs Save (as .ced) Save (other types)

Several file formats
supported (Polhemus,
BESA, El Guide ...)

use BESA file for 4-shell dipfit spherical model =
C:\sers\julie\Documents\MATLAB\eeglab\pluginsidipfit2
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Import channel locations

I Swartz
Center for
Computational
Neuroscience

| ul=]
| 000 |
LEYE
-45.1543
054374 Transtorn axed |
0.79487
075817 gz polsr s s g

-0.15585 Sph. -> polar & xyz
451543
78725

1.1379

Folar -= sph. & xyz
“ X [rotate X-Z plane) n

Set head radius

Set channel types
et reference ‘

EEG

¥

< | < | > | >> | Appendchan

| INose along £ - Plat 3-D (xyz)

Read locs help Look up locs Save (as .ced) Save (other types)
Help
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LEYE
-45.1543
0.54374
0.79487
0.75917
-0.15585
451543
-7.8725
1.1379

Opt. head center

Rotate axis

Transform axes M siiig

Center for
Compu(ational
Neuroscience

Xyz -= polar & sph.

Sph. -» polar & xyz

Folar-= sph. & xyz

Set head radius

Set channel types

Set reference

AT ch:

Flot 2-D | Nese along +X p_FPlot 3D (xyz)
— I (
il Look up locs Save (as .ced)

File Edit View Insert Tools Desktop Window Help
NEEL K RAXRUDEL- |G| 0E | 8D

Channel locations

File Edit View Insert Tools Desktop Window Help

Nade |k |RUPEeL | 3|0E a0

e . N__IJ:PTFF”ZFPZ‘FS

AF3 SAFZ AF
froFT :
PR3 o F o2 6T O

llrcsecy FCH#FCRFCarCar
#TT +C54C3 +C1 +CZ +C2 +C4 +CE +T8

[PPSR CPICPECRZPiceg,
— P3.p1+PZP2PY, JJF10
’F,?F’Q PG,

Pégoz +POZ ’P%OS

P08 01 ,07+02  +PQ

71 of 71 electrode locations shown

-18, 2012, Beijing, China: Julie Of




Imported channel locations

LN B

B E€GLAB v7.17.18 SRR X
File Edit Teools Plot Study Datasets Help &
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Pre-processing pipeline

Import event markers

and channel locations | > E \

Collect high-density
EEG data (>30 chan)

Import into EEGLAB

Re-reference/
down-sample
(if necessary)

High pass filter
(~5-1Hz2z)

Examine raw data >E—

f— <
|

Reject large artifact
time points

Reject bad channels
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Re-reference data (if necessary/desired)

SOy o LT [T )
L LR TP N b g T ey /
I N R AL Hpe i il .
S i 2t I Swartz
Center for
Compu(ational
Neuroscience

[ EEGLAB V1022

Plot Study Datasets

For example,

Help

Change sampling rate
Filter the data

average reference

Re-reference

Interpolate electrode

Reject continuous ¢

Extract epochs
Remowe baseline
Run ICA

Remove compone

[ s B N e p R F N [ —

Automatic channel

Automatic epoch

I P
LEYE REYE [ ]
\.. |

Cancel || Ok |

Reject data epochs

Reject data wusing I
MNFT plugin
SIFT

Locate dipoles usink

Peak detection using EEG toolbox
FMPRIE Tools
Locate dipoles using LORETA
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Re-reference data (if necessary/desired)

oy
b

Computaﬂona!
\;E, Neuroscience

i N
l] EEGLAE v10.2. 11- LI_IQ B (oo
File Edit Plot Datasets Help OR, re'rEference tO
#1 Change sampling rate Uuous ':USIE ?hiﬁlctrl EID
R : TH : 1 select sevara
Filter the data b (i.e.) 'linked mastoids
File Re-reference J set gg : gg -
Chz [Interpolate electrodes 38 - 1
Fraj  Reject continuous ,:fu pop_reref - average reference or re-reference data | = | E] 2 .|ﬁ 33 - CZ
Epc  Esractepochs 3[1] - gi
EVE  Remove baseline Current data reference state is: unknown 42 - CB
Saf  Runica 43 - T8
Epc ["] Compute average reference 44 - TP9
R
Epc EmovE '_mmpmen Re-reference data to channel(s): TP9 TP10 J 45 - TP7
Automatic channel 46 - CP5
RHef 47 - CP3
Chz [ | Retain old reference channels in data 483 - CP1 i
ICA _ Exclude channel indices (EMG, EOG) e
Dat  Feject data using IC 50 - CP2
Add current reference channel back to the data | 51 - CP4
Rl 53 - P8 |°
_ _ Help Cancel Ok | 54 - TP1O
Locate dipoles using 55 - P7
Peak detection usin® — E6 - P&
FMRIB Tools ) gg ] E? M
Locate dipoles using LORETA b 59 - PZ
EEG = pop reref( EEG, 39); B e
Cancel Ok
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Save new dataset, keep old one

—_— F 4
) Dataset info -- pop_newset() l — | (=] |_-Eh]
What do you want to do with the new dataset?
Mame it: Sternberg Continuous -- Reref'd Edit description

Save it az file:

What do you want to do with .- old dataset (not modified since last saved)?
Oweryerite &0 memary (2et=yves; unset=create a new datazet)

m
[§1]

e
AL

nter for
Computational
Neuroscience

Cancel | Help Ok
L%
B Enter fil [ )
el F EEGLAB v7.1.7.18b i o o |
Savein: | |, MATLAB =l & B File Edit Tools Plot Datasets Help >
Ve MName ‘ Date modified Type :
Rec;'ﬁaces external 11/10/2009 5:54 AM  File folder —#2: Sternberg Continuous -- Rere...
functions 11/10/2009 5:50 AM  File folder
! plugins 11/10/2009 5:52 AM  File folder Filenarme: none
Desktop sample_data 11/10/2009 5:52 AM  File folder Channels- ner frame 70
= sample_locs 11/10/2009 5:52 AM  File folder Frames per EpDCh E10123
i Epochs 1
Libraries
Events 1303
.,! Sampling rate (HZ) 250
Computer Epoch start (sec) 0.000
‘i_-‘ Epoch end (sec) 2440 528
Feference L
Metwork
e Channel locations Yes
4 m L ICA wigights YES
File name: [ | Save | Dataset size (Mhb) 349
Save as type: | =set) ~| Cancel

[ALLEEG EEG CURRENTSET] = pop newset (ALLEEG,EEG, 1, 'setname',..

'Sternberg Continuous -- Reref''d’);
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Multiple active datasets (ALLEEG)

Sy e Iy M | VI | /
5 [B¥] bl . | I\ f i ¢ | ' A /.
AR aaBE i ] i vl - Cor iy - oy i | P (AR [ R
JIIA T Py g W e

ORI A RN Il [ /
e Bl Swartz
i Center for
Computational

Neuroscience

B EeGLAB V71618 oclu=nimeSon | [ B EEGLAB VIO

File Edit Tools Plet Study Datasets Help File Edit~ Tools Plot Study EEEEHIs

Dataset LiSternberg Continuous Data
v Dataset 2:5ternberg Continuous -- Reref'd

Select multiple datasets
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Pre-processing pipeline

Import event markers

and channel locations | > E \

Collect high-density
EEG data (>30 chan)

Import into EEGLAB

Re-reference/
down-sample
(if necessary)

High pass filter
(~5-1Hz2z)

Examine raw data >E—

f— <
|

Reject large artifact
time points

Reject bad channels
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Filter the data (if necessary/desired)

P - / S a%ﬂj
R 5_-*‘4 Center for

Computatlona!
‘7‘ Neurosdence

Lower cut off frequencies require longer stretches of continuous data

- R ™
n Filter the data -- pﬂ-p_eegﬁm El&lg

(B eecLae v7.27.180 - LI_IQ

Lowwer edge of the frequency pass band (Hz) 1 H | h_ aSS
File Edit @GLIEE Plot Study Datasets Help gl el @ e (Femaey Poss b (4] g p
#1 Change sampling rate | FIF: Fitter order (default is automatic) d d
Filter the data Basic FIR filter || Match fiter the data instead of pass band neeae
. Re-reference Short IR filter || Use (sharper) FFT linear fiter instead of FIR fitering
Fe for ICA
Chz Interpolate electrodes Plot frequency response
[

Reject continuous data by eye

Hel Cancel Ok
Extract epochs —pl I

Remowve baseline

- - B
fun1cA B Dstset i — pop newer) [N e
Remaove components -

Automatic channel rejection What do you want to do with the new dataset?

Autornatic epoch rejection rlame it: Sternberg Continuous Data-HighPass Edit description I
Reject data epochs b [ Save i as file: Browse |
Reject data using IC4 b
Locate dipoles using DIPFIT 2x P What do you want to do with the old dataset (not modified since last saved)?

Owergvrite it in memory (2et=yes; unzet=create a new datazet)

Peak detection using EEG toolbox

b
AR Ténls _ Help | Cancel I

Locate dipoles using LORETA b
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Pre-processing pipeline

Import event markers

and channel locations | > E \

Collect high-density
EEG data (>30 chan)

Import into EEGLAB

Re-reference/
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(if necessary)

High pass filter
(~5-1Hz2z)

Examine raw data >E—

f— <
|

Reject large artifact
time points

Reject bad channels
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Scroll channel data

& o
= Computation:
= Neuroscience
- Scroll channel activities -- eegplot()
EEGLAB v7.17.18b L Figure Display Settings Help ]
File Edit Toaols m Datasets Help
#9: ot Channel locations r )
—#£. olel =
Channel data (scroll) (] % =
iy i e R L e e LAY
Channel spectra and maps R M Y
Filename: . e - o EEAfTers
Channel properties by
Channels = e et
Framos b == Seeaseeene e
EpDEhS ' e R e e e e e e e e o e e
Events ’ . % Y A i L AL A S At W
Sampling | === R e e e e
Epoch Sta  component activations (scrol e e e
Epochenc fEEae e eSS s e
omponent spectra and maps 1 — e e e e e e
Reference Bl Eo— o —— e
Component maps b s S
Channel Ic e A s
ICA weight Component properties m—— e
. iy Ny, N Wy VL Ny Ll S Y A F -
Clataset =i ﬁmm
EA e T e e e
; == =
i e e e
a b o e e e e P o ]
—— " S B e e R e R e R e o 22 Seale
Data statistics » = 3719
e A T o A A e A N e AU S A
Time-frequency transforms ] -~ =
85 86 87 88 89 90
Cluster datasetICs
Chan.  Time alug g
CANCEL ‘ Event types | =| = & | 2] = Leve s7omse 4sw:s | 3719 J REJECT

>> pop eegplot(EEG,1,1,1);
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Scroll channel data

-
Scroll channel activities -- eegplot() =

Neuroscience

Figure Display [ Settings) Help

Event markers

D

L]
L 5]
—

; oy

e o

channels, E=n—y

R e e A e B e iy i T S
i e e et
tlme, __._"_"m_.‘._ Y
e e e e e L e
events ] e
.
o e e
e o i
"_..._lh_“._“ e e T e T
e Il i Sy by ey AP
e e L e e e
g A P e e o ey Y R e
i, A e Y o By S e A ¥ o W
sec/epoch [EaEa=—rs—rmy e
—— Ly S ————
e e
e e
e e e s a e e e AT
T e e o e e e
e e ol e s e AT iiiapg e - P N oo
\ S
__‘
o
ol
o o o o
a7 a8
Chan. Tirme Walue

REJECT

Scroll
buttons

scaling
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Pre-processing pipeline

Import event markers

and channel locations | > E \

Collect high-density
EEG data (>30 chan)

Import into EEGLAB

Re-reference/
down-sample
(if necessary)

High pass filter
(~5-1Hz2z)

Examine raw data >E—

f— <
|

Reject large artifact
time points

Reject bad channels
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Remove channel

N nt
-~ Compuitational
\7\‘3\ Neuroscience

Figure Display Settings Help

1) Identify bad channel

Scale
35
| : | e A e oA e e AL (R
450 451 452 453 454
Chan. Time alue
LR EuEiE= | < | TE | s A = o1 451.0385 35619 35 j REJECT
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File M08 Tools Plot Study Datasets Help

Dataset info
Event fields
Eventwvalues
About this dataset

Channel locations

Select data using events
Select epochs or events

Copy current dataset
Append datasets
Delete dataset(s)

E

Scrall dataset
o |
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If not checked, will result

F&

in dataset with one channel

s | ovew | o |
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Channel removed

gy C&mpum‘b nal
\ .~ science
B0 et e ey S | —

Figure Display Settings Help

Channel data without 'F6' (see supplementary material for interpolation)

m

U gy S Ay Y Ly - S A N Al A S S A i Ny N g oot P Mgtts A ok

e Scale
3 WWNWWWWWW
s 35
i i 1 i
450 451 452 453 454
Chan. Time Yalue

LT EERES ‘ == = 449 I P8 4535014 41308 35 = FEELT
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Pre-processing pipeline

Import event markers

and channel locations | > E \

Collect high-density
EEG data (>30 chan)

Import into EEGLAB

Re-reference/
down-sample
(if necessary)

High pass filter
(~5-1Hz2z)

Examine raw data >E—

f— <
|

Reject large artifact
time points

Reject bad channels
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Reject continuous data

Sl 2] | LR L [ E .
L Vi b s N P A R S [
e R T Hem W a2 (I
S i 2t I Swartz
Center for

Equivalent

Compu(ational
Neuroscience

Bl eoLse 71718t [Py )
File Edit Tools BRlE8 Study Datasets Help

Channel locatians

Channel data (scroll)

Channel spectra and maps
Channel properties
Channel ERP image
Channel ERPs

ERP map series

Sumy/Compare ERPs

Component activations (scroll)
Component spectra and maps
Component maps ]
Component properties
Component ERP image
Component ERPs ]
Sum/Campare comp. ERPs

Data statistics

Time-frequency transforms

Cluster datasetICs

— i
EEGLAB v7.1.7.18k E=REEN X )

File Edit L Plot  Study  Datasets  Help

Change sampling rate

Filter the data

Re-reference

Interpolate electrodes
ontinuous data b

Extract epochs

Remawe baseline

Run ICA

Remowe compaonents

Automatic channel rejection
Automatic epoch rejection
Reject data epochs

Reject data using ICA

Locate dipoles using DIPFIT 2.x

Cance  Comtinue |
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Reject continuous data

s |

:

Scale

1

-t S

5

o
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]
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Rejecting data for ICA

 Scroll chani
Figurs Display Settings Help

2
Center for-
Computafk:nal
Neuroscience

Reject large muscle or

otherwise strange events...
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Pre-processing pipeline

Import event markers

and channel locations | > E \

Collect high-density
EEG data (>30 chan)

Import into EEGLAB

Re-reference/
down-sample
(if necessary)

High pass filter
(~5-1Hz2z)

Examine raw data >E—

f— <
|

Reject large artifact
time points

Reject bad channels
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Independent Component Analysis

.-

pe
‘:&

Channels

x = scalp EEG

x = W1*u

W = unmixing matrix

W*x =u
ICA

u = sources

MMW
MWWAMVWWWWW"

I

Time
W1 (scalp projections)
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“Secrets” to a good ICA decomposition
» Garbage in... garbage out (it’'s not magic)

> Remove large, non-stereotyped artifacts

> Do you have enough data? (based mostly on time, not frames)
* ~30 min of data for 60-70 channels, ~60 min for > 200 channels

» High-pass filter to remove slow drifts
* low-pass/ notch filters usually unnecessary

> Remove bad channels

> Data must be in double precision (not single)

EEGLAB Workshop, June 16-18, 2012, Beijing, China: Julie Onton — Getting started



Runica options

Computatlona!

Option Default Comments go—

File  Edit Flot Datasets  Help N
41 Change sampling rate S ‘extended’ 0 1 is recommended to
" | Fiter the data b find sub-gaussians
. Fe-reference
Filernz _ _ t
Chani  Reject continuous data by eye ‘stop’ le-7 final weight change = stop
Frarme Extract epochs

Bpot Femove baseline

S e ‘Irate’ determined too small - too long...
samp SIS from data too large = wts blow up

Epoch Femove components

iﬁ::; Autamatic epoch rejectian . , h |
chani  Reject data epochs \ maxsteps 512 more channels - more steps
[ A, w Reject data using ICA »
Datas, | ,rate dipoles using BESA 3 pca O or Decompose only a
Locate dipales using DIPFIT 2. » EEG.nbchan  principal data subspace
Laplacian F
FMEIB Tools 4 .
Other algorithms:
Run ICA decomposition -- pop_runica() binica,SObi,aCSObirO H
PCA plugin ICA algorithm to use (click to selact) FUnica =
Commandline options (Sea halp massages) T T _|
Channel typels) or channel indices | ... Typas | ... channels |
Cancel | Help | Ok \
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Online bias adjustment wi

Starting weights are the
Sphering the data ...

step 1 - lrate 0,001000,
step 2 - lrate 0,001000,
step 3 - lrate 0,001000,
step 4 - lrate 0,000980,
step 5 - lrate 0,000960,
step 6 - lrate 0,000941,
step 7 - lrate 0,000922,
step 8 - lrate 0,000904,
step 9 - lrate 0,000886,
step 10 - lrate 0,000868,
step 11 - lrate 0,000851,
lrate 0,000834,
lrate 0,000817,
lrate 0,000801,
lrate 0,000785,
step 16 - lrate 0,000769,
step 17 - lrate 0,000754,
itep 18 - lrate 0,000739,

P
oF oF oF oF
@ @ @ 0
TUTUD
ol el
(T PN Iv) X
[

Runica progress...

Press Button to interupt runica

Interupt

11 be used,

Removing mean of each channel ...
Final training data range: -171,806 to 179,094
Computing the sphering matrix,,,

identity matrix ...

wchange 16,85061324,
wchange 0,26760405,
wchange 0,79058323,
wchange 0,66700031,
wchange 0,62843071,
wchange 0,73967955,
wchange 0,73727229,
wchange 0,74051387,
wchange 0,74536137,
wchange 0,72101402,
wchange 0,14690114,
wchange 0,11822100,
wchange 0,75552366,
wchange 0,26739750,
wchange 0,12123251,
wchange 0,1028560E6,
wchange 0,03770433,
wchange 0,09544423,

Beginning ICA training .., first training step may be slow ...

angledelta 0,0 deg
angledelta 0,0 deg

angledelta 104,0 deg
angledelta 147,2 deg
angledelta 146.5 deg
angledelta 150,7 deg
angledelta 151,6 deg
angledelta 137.9 deg
angledelta 156,0 deg
angledelta 143,7 deg
angledelta 102.5 deg
angledelta 114,3 deg
angledelta 100,6 deg
angledelta 109,1 deg
angledelta 94,2 deg
angledelta 110,7 deg
angledelta 118.6 deg
angledelta 117,1 deg

Kurtosis will be calculated initially every 1 blocks using 6000 data points,
Decomposing 122 frames per ICA weight ((1089)"2 = 133175 weights, Initial learning rate will be 0,001, block size

Learning rate will be multiplied by 0,38 whenever angledelta >= B0 deq.[< P T T e A
More than 32 channels: default stopping weight change 1E-7
Training will end when wchange < 1e-07 or after 512 steps,

> 1

wchange 0,00000082,
wchange 0,00000061,
wchange 0,00000057,
wchange 0,00000054,
wchange 0,00000055,
wchange 0,00000047,
wchange 0,00000046,
wchange 0,00000045,
wchange 0,00000041,
wchange 0,00000036,
wchange 0,00000033,
wchange 0,00000023,
wchange 0,00000030,
wchange 0,00000023,
wchange 0,00000023,
wchange 0,00000023,
wchange 0,00000021,
wchange 0,00000020,
wchange 0,00000013,
wchange 0,00000015,
wchange 0,00000014,
wchange 0,00000014,
wchange 0,00000013,
wchange 0,00000012,
wchange 0,00000011,
wchange 0,00000010,
wchange 0,00000010,
wchange 0,00000010,
wchange 0,00000008,

Sorting components in descending order of mean

b’ d csh

| |step 241 - lrate 0,000002,
step 242 - lrate 0,000001,
step 243 - lrate 0,000001,
step 244 - lrate 0,000001,
step 245 - lrate 0,000001,
step 246 - lrate 0,000001,
step 247 - lrate 0,000001,
step 248 - lrate 0,000001,
step 249 - lrate 0,000001,
step 250 - lrate 0,000001,
step 251 - lrate 0,000001,
step 252 - lrate 0,000001,
step 253 - lrate 0,000001,
step 254 - lrate 0,000001,
step 255 - lrate 0,000001,
step 256 - lrate 0,000001,
step 257 - lrate 0,000001,
step 258 - lrate 0,000001,
step 259 - lrate 0,000001,
step 260 - lrate 0,000001,
step 261 - lrate 0,000001,
step 262 - lrate 0,000001,
step 263 - lrate 0,000001,
step 264 - lrate 0,000001,
step 265 - lrate 0,000001,
step 266 - lrate 0,000001,
step 267 - lrate 0,000001,
step 268 - lrate 0,000001,
step 269 - lrate 0,000001,
Permuting the activation wave forms ...
>

Computatlona!
Neuroscience

angledelta 101.5 deq
angledelta 96,1 deq
angledelta 97,5 deg
angledelta 93,7 deg
angledelta 100,3 deg
angledelta 96,9 deg
angledelta 91,3 deg
angledelta 101,5 deg
angledelta 103,1 deg
angledelta 95,5 deq
angledelta 92,1 deq
angledelta 97,4 deq
angledelta 95,8 deq
angledelta 94,2 deq
angledelta 97,6 deg
angledelta 97,1 deg
angledelta 92,0 deg
angledelta 99,1 deq
angledelta 95,0 deg
angledelta 98,3 deg
angledelta 99,0 deg
angledelta 94,3 deg
angledelta 95,4 deg
angledelta 94,1 deg
angledelta 96,1 deq
angledelta 94,8 deq
angledelta 94,5 deq
angledelta 97,7 deq
angledelta 95,1 deq
projected variance ...

EEGLAB Workshop, June 16-18, 2012, Beijing, China: Julie Onton — Getting started
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ICA weights in EEG structure

r— N f
L Terminal -0 x B Figure 4
File Edit View Terminal Tabs Help File Edit View Insert Tools Desktop Window Help k
=> EEG (o] DEES | R ARAONDR LS| 08| am
EEG =
1 2 3 4 5 B |
getname: 'faces_4 continucocus’
filename: 'faces_4.set’
filepath: '/home/julie/workshop0s,/’
subject: '
group: '°
condition: '
session: [] '
commenta: [15x48 char]
nbchan: 22
trials: 1
pnta: 133175
arate: 250
xmin: 0O 17 18
xmax: S2Z.6960
times: []
data: [33x133175 aingle]
icaact: [22x123175 =ingle]
icawinwv: [23x32 double]
icasphere: [32x23 double] 23 2
icaweights: [22x33 double]
Trachangingd: llxis doubre] \
chanloca: [1x33 struct]
urchanloca: []
chaninfo: [1x1l atruct]
ref: 'common'
event: [1x731 struct] 2
urevent: [1x731 struct]
eventdescription: {[]1 [1}
epoch: []
epochdescription: {)
reject: [lxl struct]
gtats: [1lxl struct] 35
gpecdata: [] +
apecicaact: []
gplinefile: ' L i
icasplinefile: '°' \
dipfit: [1xl struct]
history: [1x1632 char] 4
gaved: 'no' &
ete: [] jo74 Sternberg Continuous
= [
P A
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Pre-processing pipeline (review)

Import event markers

and channel locations | > E \

N | <

Collect high-density

Import into EEGLAB
EEG data (>30 chan) P

Re-reference/
down-sample
(if necessary)

High pass filter
(~5-1Hz2z)

Ul

Examine raw data >|

Reject large artifact
time points

Reject bad channels

UL
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- The example data: Sternberg working memory

- File .../SampleData/stern.set
Data Continuous data (not epoched), ref'd to right mastoid
Task between 3 and 7 letters to memorize (colored black),
between 1 and 5 letters to ignore (colored green),
8 letters presented during each trial
50% chance of probe letter being ‘in-set'’

Fixation SOA Maintenance

(5 sec) (1.4 sec) (2-4sec) Probe

J T D 6 1
+1IMITL]T]IG]P][Y][Q][wW]]-

ﬁ /J\ See 'SternbergTaskExplanation.pdf' on wiki (RT)\—L

Memorize for more task details.

lgnore
Was this letter in the memorized set? | RESPONSE

EEGLAB Workshop, June 16-18, 2012, Beijing, China: Julie Onton — Getting started



Epoch on EEG.event type

(BY eeciae w0210 _LEl_lg

File Edit |Tools | Piot Study Datasets Help

 #1:

Ref

D

Change sampling rate
Filter the data
Re-reference
Interpolate electrodes

Reject continuous data by eye

ata 1

Time-locking event type(s) ([]=all)
Epoch limits [start, end] in seconds 42

Extract epochs

Remove baseline

Mame for the new dataset

Run ICA

Remove components

Automatic channel rejection
Automatic epoch rejection
Reject data epochs

Reject data using ICA

k

b

Cut-of-bounds EEG limits if any [min max]

Help | Cancel

- Extract data epum_ E

Sternberg continuous data 1}

S

(use shiftictrl to
select several)

Memorize letters: capital letters

MFT plugin

b

Locate dipeles using DIPFIT 2.x
Peak detection using EEG toolbox

b

— Probe letters: ‘r’ preceding capital letter (e.g., ‘r

Ignore letters: ‘g’ preceding capital letter (e.g., ‘gB’)

B’)

FIMRIE Tools
Locate dipoles using LORETA

2

b

>> EEG = pop epoch( EEG, {'B','C"‘,

|Q| 'Rl IS' ITI IV' IW\..

EEGLAB Workshop, June 16-18, 2012, Beijing, China: Julie Onton — Getting started

'X' 'Y' '2Z' }, [-1 2], 'newname',

'Sternberg Memorize letter epochs',
'epochinfo', 'yes');

|F\,|G\,IH\,IJ\,lK\,lL\,IM\,'N\,'P\...

i=s<wITOoTVEZ=E=rmz~Innoom

Cancel Ok




Extract epochs

AR sl 4 W i Ll - Co iy - /! [ | ae, LT v, .

/
/

IR Swartz
Center for
Computational
Neuroscience

Sternberg Memarize epochs Edit description
Browse
.

'1|| --.':'— ren
=

FEGLAB v10.2.4.

File Edit Tools Plot Study Datasets Help o
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Exercise

ALL
-Load stern.set (continuous data)
-Do not save your changes under the same filename!

Novice

-Scroll channel data and explore plotting options under 'Settings'.
-Reject noisy time points by visual inspection

-Import standard channel locations

-Practice preprocessing steps described in this lecture

Intermediate / Advanced (requires supplementary material)
-Remove a channel and then replace it by interpolation

-Compare this signal with the original when you do this with a
‘clean' channel

-Epoch data even of interest, plot Channel ERPs from Plot menu

-Try different filter methods and cut-offs, compare results
EEGLAB Workshop, June 16-18, 2012, Beijing, China: Julie Onton — Getting started



Supplementary lessons
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Auto-detection of noisy channels

Center or

\ / Computational
/ Neurosclen(e
=y

File Edit Plot Study  Datasets Help

Change sampling rate

Filter the data b Data——

i B ™
Re-reference n Reject channel -- pnp_rejcl‘;anmé Ehlg

et

—#1:

Interpolate electrodes
. . Electrode (numberi=); Ex: 2 4 31 1:71
Reject continuous data by eye

Meszure to use: Probakility v.
Extract epochs Marmalize measure (check=on): .

Remowe baseline

Run ICA

Threshald limits [max): 5

Remowe components Cancel

0 . o
E Automatic channel rejection

Automatic epoch rejection

Reject data epochs b

Reject data using ICA ]

Locate dipoles using DIPFIT 2.x P

Peak detection using EEG toolbox
FMPRIE Tools k
Locate dipoles using LORETA r

>> EEG = pop rejchan (EEG, 'elec',6 [1:71] , 'threshold',5,...
'norm', 'on', 'measure', 'prob');
EEGLAB Workshop, June 16-18, 2012, Beijing, China: Julie Onton — Getting started



Auto-detected noisy channel

Computational
Neuroscience

F|gure Display Settings Help

Scale
R e S S o o ks AR A £ it A PR o b e e i B A A A P e AL eSS Tl e O
1 35
i i i o g
450 451 452 453 454
Chan. Tirme “Walue

2
CANCEL == < 443 > => P& 4521146 25647 35 = REJECT
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Interpolate bad channel

IR Swartz
Center for
Compu(ational
Neuroscience

Choose a channel from other dataset

File Edit BIELH

Change sampling rate

Plot Study Datasets

Help

Select from non-data channels

Select from ather dataset
Use list of other dataset

Filter the data b

Re-reference

Interpaolate electrodes Eoherical B

Auto-select deleted
channel from other dataset

Reject continuous data by eye
o |

Extract epochs
Remowe baseline
Run ICA

Remowe components

Automatic channel rejection
Automatic epoch rejection

Reject data epochs ]
Reject data using ICA k

Locate dipoles using DIPFIT 2.x »
Peak detection using EEG toolbox
FMPRIE Tools

Select from non-data channels

cancel| i |_ox |

Locate dipoles using LORETA

Select from ather dataset

Usze list of other dataset

Spherical -
o |
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Interpolated channel

Figure Display Settings Help

Channel order changes, but scalp location is correct

Scale

: ; e R R D R e I PR S R I R e

450 451 452 453 454

Chan. Time Walue

|
CAMCEL Event types == = 449 = == LEYE 453 3295 35 REJECT
4 —EEGL—AIJWOTkS#]Op,JJune 16—18725T27éeljlng China: Julie Onton — Getting starad




Merge (append) datasets

Ve M A M | VI \ /

v ¥ Pyt v | I h | i { ) Lo /.

LT I A 4 | | W [l yol Al ) 1 A ] [ i} T R T L [} " | . y
SOV T g W B

gl [ RN L o { ;
- I Swartz
Center for
Compu(ational
Neuroscience

 File J208 Tools Plot Sty Datasets Help
Dataset info
Event fields
Event values
About this dataset

Channel locatians

Select data
Select data using events
Select epochs or events

Copy current dataset

Append datasets
Delete dataset(s)
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Merged datasets

. NI . 0oV ) et ! T | /
P TV AT ) i i 1 [y g h A ! : i ) oh /
R TN LR N T N P AR sl i ] i vl o N v JA R T L e T [ /

1 L LTS I . Wt e VU A R (P A T N B TP Loh s .‘ll PR BT Wk A i W]

AR T el N [l R v bl =\
' § ¢l | [ A k B Swartz
: Center for

Computational
Neuroscience

B EEGLAB V727 EE )

File Edit Tools Plot Study Datasets Help
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Renaming events

B EGLAR v7.1.7.18b -

File mnmls Plot Datasets Help o

Dataset info

[ Event fields ntlnuuus = Rereu._

Event values

About this dataset

. T
Channel locations B10133
Select data 1

Select data using events 1303

Select epochs or events 260

Copy current dataset 0000
A 2440528
ppend datasets -
Delete dataset(s)
Tes

Center for-
Computational
Neuroscience

1) input original 'type' code
2) Input new 'type' code
3) Keep/delete all other events

Select events — pop_selectevent()

Selection Field Descriptions Selection {value, list or real range "min==max"} If set, select
Field To adit: Bdit = BEvent fialds Ex "Target" or 2:4,5 or 4.5 <= 13 all BUT these

Evant indices

_

latancy (s) Mo description

_

Dype Mo description

bpl _

_|Salect all events MOT selected abova Jat this button (1o left)and "all BUT" buttons (abowe) for logical OR

Fename salected event typels)as type:

Retain ald avans spnonamasiin (naws fizld namad:

buttonl

|_|Keep only selected events and ramowve all other events




- &

S v
28

Renaming events

,
B EEGLAB v7.1.7.18b

File N0 Tools Plot

Dataset info
Event fields

Datasets Help

ntinuous -- Rere...

About this dataset

: il
Channel locations B10133
Select data 1
Select data using events 1203
Select epochs or events 240
Copy current dataset 0.000
" 2440 528
ppend datasets c7
Delete dataset(s) i
ICA weights e
Datazet size (Mb) 249

Edit event values — pop_editeventvals()

Edit event field values {currently 32 events)

2
Center for-
Computaﬂonal
Neuroscience

Dalate avant

Latency (sec) | | g 774
Type | [ ( buttonl )
Event Num
Insert event | << | < | 3 B

>> | Append event |

Re-order events {for review only)
Main sorting field: i
secondary sorting fiald:

Re-sort |

Cancel |

_IClick for decreasing order
_IClick for decreasing order

Ok |

EEGLAB Workshop, June 16-18, 2012, Beijing, China: Julie Onton — Getting started



Analysis of channel ERPs
‘ [ B £RP data and scalp maps - pnp_timtopﬂ{}i ESHEERTSE)

Y Plotting titme range (ma): -200 500
xf‘f Scalp map lstencies (ms, Mal -= max-REkz) Mak

Plat title: ERP data and scalp maps of !

g S Scalp map options (see == help topaplat):
B EEGLAB v7.17.18b ‘ e

File Edit Tools IHEI Datasets Help L] fl! Cancel Help

Channel locations ¥ = =

—#3: Stel hs EHS ®e -

Channel data (scroll)

_ Channel spectra and maps 76
EILEHEIH‘IlE. Channel properties
AfNnels
Frames pe Channel ERP image I
Epaochs Channel ERPs b With scalp maps
Events ERP map series b Inscalp/rect. array

Sampling | Sum/Compare ERPs
Epoch sta Component activations (scroll)

Epoch enc Component spectra and maps
Feference - : ,
omponent maps
Channel I _ .
1T weigh Component properties ::,
Diatazet =i Component ERP image E
Component ERPs » ©
Sum/Compare comp. ERPs r=
L
Data statistics ] -lc—:"
Time-frequency transforms k o
Cluster dataset ICs

>> pop_timtopq (EEG, [£200 5001, [NaN] , /ERP data and scalp maps');




Analysis of channel ERPs

Computatlona!
Neuroscience

Channels to plot 1.7

-
B EEGLAB V717180 ‘ [ B Fgure 2 piotiop o
File Edit Toaols Study Datasets Help E Fi
: DEEE 2L
annel locations
#9: St Ch [ locat 4 h
T HL. el =ns
Channel data (scroll) Stemberg memorize epochs
: Channel spectra and maps REYE
Elfl'leannanrges. Channel properties
Frames pe Channel ERP image
Epochs With scalp maps LE‘?EVAAV i FF%V% Fhr F%‘T&W‘
Events ERP map series 4l Inscalpfrect. array AT ﬁ‘ 1 H, I A
Sampling Sum/Caompare ERP3 £ V%'Vf:r £ \ " | T A A F%Fﬁ%%
Epoch sta Component activations (scroll) F3 F?F e F?aU F2 £
Epoch enc Component spectra and maps T FF’{L s T FT10
Reference FCs FCBV&'—% wﬂvﬁva Epv,aw e T8
e [ Component maps 4 FC1 FeY | Fea ) FCA ]
ICA weight Component properties i \ ] |
2 2 I Vﬂv—ﬂm

Dataset si Component ERP image v cs gy’ N " CEW_ o b3 8

Compaonent ERPs » i i T

Sum/Compare comp. ERPs TP?}AA‘ CP5 M7 CP3 CP CPZ 8| L Tpﬁ%f’@_‘

Data statisti [ P9 1

ata statistics ; A p’}%ﬂ@ Pﬂlﬁﬁﬂ* péﬁ_'_ﬂvﬂ”p%%'@& b y TP%V“‘
- — ™ P8
T hic ERP plat - pop_plott [E=REER 57
n opographic plot - pop_plottopo() e péﬂ’“&“ 5
O {

Plat title Sternberg memorize epochs
Flot zingle trialz [ ] iset=yes) v
Flat in rect. array [ (set=yes) %
Other plat options (see help) i, 1 -597'2“” D
Time (ms)
Cancel I Help | Ok
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Channel ERP in rectangular array
-

& Center

k- e : Cdﬁ;utaﬁonm
A&-‘? Neuroscience
- = B u Figure 2 plottopol
u EEGLAB v7.1.7.18b ‘ == .
File Edit Tools Datasets Help & D& pLD
Channel locations 4
#2: Stel Channel data (scrall) zhs Stemberg memorize epochs
: Channel spectra and maps 1 _9 _1 4 _5 _§ -1 3
Elfl]eannanrgles- Channel properties - Vf\ u/\m Av Avm A\MVM = Vnuw - Vﬂw "’“ﬁ T ”‘L“‘V T
F Channel ERP image || A A 4 I L 1 1 1
rames pe . i -9 10 -1 12 -3 M 116 s
Epochs Channel ERPs 4 With scalp maps A 2 5 T N A da I A
Events ERP map series | Inscalp/frect. array I T VA I L A pf L i Y T VY
Sampling 1 Sum/Compare ERPs T 18 19 2N Y n o Y
EpDCE sta Compaonent activations (scroll) Vf\ - \\/{h }Vﬂ v Bﬁv quﬂw{wm "‘*““‘UAVW" et u-ab-«-vﬂw-?
ROEh enc Component spectra and maps 4 4 L 4 4 4t
Reference - : , 1% . v % Vi 10 =] 2
Channegl |c ~ —°TPenemmaes NI A L T{\W _j/\ 11 A o
(A, weigh1 Component properties V V D/ D/ D/ V __V __V
Diataset si  Component ERP image -3 ¥ T35 % ﬁ i -3 A0
1 A n, A, i i i f\
Component ERPs 4 Foak 7 P,“ i P/ V v ke WA
Sum/Compare comp. ERPs L L + L L &
—— —— 41 >y 1 — 4 16 47 14
Data statistics » A . I I . A A
- = “U 7 U J\J F v v
Topographic ERP plot - pop_plottopo() =1L < < L < 4 4
n santiels & a7 e 49 50 J51 52 53 54 55 56
AN 1 a p AW AW
Chiannelz to plot 1:71 K AT \YU" Cai JV - ey
Plat title Sternberg memorize epochs 5 58 59 50 81 8 8 8
Plat single trials I:‘ (set=yes Wk o W o nV/’A\M n\’-"\}m/ﬁ\m A\/JU /\V J\U . ]\Um - ﬂvf\m"\.
Plat in rect. array ig } 1 1 J_VU J_ J_ 1 1 €97 |
el esens reee e weelir' 1 g % d 8 ﬂg H] Tl
yer sl a o wl oA sl adles allee sl
v kil \Jf T \JJ v VTV ViV 3

Cancel
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Analysis of channel ERPs

‘ B Plot ERP scalp maps in 2-D -- pop_topoplot() =HRCIN X
e v, Plotting ERP scalp maps at these latencies 0;25;2?5|
7 [range; -200to 496 m=, Mabl -= empty;
B EEGLAB v7.1.7.18b o =
File Edit Tools m Datasets Help
Channel locations b
—#2: Stel ths ——

Channel data (scroll)

Channel spectra and maps

Filename: :
Channel properties
Channels
Frames pe Channel ERP image
Epochs Channel ERPs b
Events ERP map series b
Sampling 1 Sum/Compare ERPs In3-D
E[CIIIII:h sta Component activations (scrall)
Ep?Ch Eng Component spectra and maps
ETEMENCE
Eherg] e Component maps »

|CA weighf Component properties
Dataset si Component ERP image

Component ERPs »
Sumy/Compare comp. ERPs

— . —
Data statistics L

Time-frequency transforms ~ #

Cluster datasetICs

Sternbery memorize epochs

LS

pop topoplot (EEG,1,[0:25:275], ‘Memorize',[3 4],0,'electrodes’', 'off');
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Compare ERPs across conditions

Y '-."“.’.- " I". | A

EGLAB v7.17.18 S R
File Edit Tools Plot Study EEECHIS o |

Dataset LiSternberg Continuous Data

v Dataset 2:5ternberg Memorize epochs

Dataset 3:5ternberg Ignore epochs

Select multiple datasets

How do 'Memorize'
and 'lgnore' ERPs
differ?
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Compare ERPs across conditions

B EEGLAB v7.1.7.18b

Lo e S|

File Edit Tools [l

Channel location

#2: Stel Channel data (scr
: Channel spectra :
EI:_IEﬂamlE_ Channel properti
Arnnels
Frames pe Channel ERP ima
Epochs Channel ERPs
Events ERP map series

YL SumiCompare

Datasets Help u |

Compare ERPs

m ERP grand average/RMS - pop_comperp()

from two conditions

Datazets to average (ex: 1 3 4 23
Datasets to average and subtract (ex: 56 7T
Plot difference

Channels subset ([]=all):

Highlight =ignificart regions (01 -= p=01]

Lze RMS instead of average (check): |:|

Lony pass (HZ) (for dizplay only) 20
Plottopo options ('key', "wal'): Help |

Cancel Help

nter for-
Computational
Neuroscience

ESEEE™)

P

std.  all ERPs

NN
O]

Ok

Epoch sta Component activ
Epoch enc c

amponent spec

Feference
Channel I Component map
ICA weight Component prop
Dataset si  Component ERP
Component ERPs
Sum/Compare cc

—

Data statistics

- —_—
»

Time-frequency transforms ~ #

Cluster datasetICs

>>pop comperp (ALLEEG,1,[2 3],[], 'addavg',6 'off', 'addstd', 'off"',
'addall','on',6 'diffavg',6 'off','diffstd', 'off', 'lowpass’',k 20,

"tplotopt', {'
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Compare ERPs across conditions

Neuroscience

u Figure 3

File

bed& 2a0

Click on an axis

to see larger image

File

& N e

S
—— #2 Sternberg Memorize epochs (n=600)
— #3 Sternberg Ignore epochs (n=300)

Potential (V)

100 200 300 400
Time (ms
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Analysis of ERP differences

Plot difference
fomPeF hetween two conditions B

20
Help “wlir', 1

Cancel o |

>> pop comperp (ALLEEG,1, 2, 3,'addavg',6 'off’', ..
'addstd','off', 'diffavg','on',K6 'diffstd’', 'off’,
'lowpass',20, 'tplotopt',6{'ydir',k1l});
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Analysis of ERP differences

R

-«
nFigurE2 = ﬂ
DEEE 2L

ERP
difference
between
2 conditions
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Event durations

Computational
Neurosclence

Scroll channel activities — eegplot) CO | O r d e n O t es

/ event duration

=

Figure Display Settings  Help

bpd
ohje.
bp1

RN

e01
e0z
803
e04
eds
elf
ed?
208
209
elo
el
elz
el3
eld
e1s
elg
ey
e1g
e1g
e20

ezl
ezz
e23

ez4
825
k]
8z7
ez8
=2 Scale
edn
ed1

70
edz

233

Chan, Time Yalue

+
CANCEL Event types ‘ << < 0 > 55 233 51.7242 -133 70 J REJECT ‘
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Comments in EEGLAB structure

- S .

About this dataset

Data acguired by: Julis Onton
Data acquired on: Oct 15, 1874

Task ('ewventname') :

- Every trial preceded by 5 sec fixation ('fix') -
3,5,7 letters to memorize (in black, =x, 'B'])

- 5,3,1 letters to ignore (in green, =x, 'gB')

— 8-letters total per trial

— 2-4 gec variable maintenance period ("WH')

FProbe letter
press response
— Subqect was to indicate by left or right mouses
button (with right hand) whether the probe
letter was in-set (left,'in') or out-of-set
{right,'out')

— If the response was correct, subject heard one
one tone ('correct'), 1if incorrect, a different
tone ('wrong')

{in red, =X, 'rB'iprompted a button

Beference electrode placed on right mastoid

{Subject indicated sleepiness toward the end of
segsgion)

SAVE

CAMCEL |
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Neuroscience

>> BEEG.comments

B E£GLAB +7.16.18b - l_l_lg

File

N Tools Plot Stud

Datasets Help

Dataset info
Ewvent fields
Ewentwvalues
About this dataset

Channel locations

MS0dhstern.set
71
B10133

Select data
Select data using ewvents

Select epochs or events

1
1303
250

Copy current dataset
Append datasets
Delete dataset(s)

0.000
2440528

Lnknown
TES

ICA weights
Dataset size (Mhb)

YES
3514

ntinuous Data———




Memory options

[

v RRRECE A | S b NN Sartz
' ' Center for

Computational
Neuroscience

Edit Toals Plot  Stuchy Datasets  Help

Import data
Itnpart epoch info 4
Import event info k
Export 3

Load existing dataset

Set when loading a STUDY

Sawe CUrrent dataset(s)

Sawve Current dataset as

Clear clataset(s)

Create stuchy 4

Load existing stuchy
Save current study
Sawe CUrent study as

e

Clear stuchy

Sawe history
Quit

=]

<=
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